
HCImage Live
Getting Started Guide

Release 5.0

November 2022



This guide, as well as the software described in it, is covered under license agreement
and may be used or copied only in accordance with the terms of the license
agreement. The information in this manual is subject to change without notice and may
not be reproduced without Hamamatsu's permission. Hamamatsu has carefully
prepared this manual, however, no responsibility is assumed for possible inaccuracies
or omissions. Some images are simulated.

HCImage is a trademark of Hamamatsu Corporation. DCAM-API and ImagEM are
registered trademarks of Hamamatsu Photonics K.K. (EU, Japan, U.K., U.S.A.). ORCA
is a registered trademark of Hamamatsu Photonics K.K. (China, France, Germany,
Japan, U.K., U.S.A.) All product and brand names are trademarks or registered
trademarks of their respective companies.

Hamamatsu Corporation
360 Foothill Road, Box 6910
Bridgewater, NJ 08807-0910
USA
+1 908.231.0960
sales@hamamatsu.com
https://camera.hamamatsu.com/us/en/index.html

Software Support
hcsupport@hamamatsu.com
www.hcimage.com



Table of Contents
Installation
HCImage Live 3
Install DCAM-API Drivers 3
Line Profile 4
Filter Control using TTL 5
The Capture Pane 6
Capture Presets 6
Camera Control 7
Binning and SubArray 7
Trigger Modes, Speed and Registration 8
Advanced Camera Properties 9
Processing 9
Capture a Color Image 11
W-VIEW and the ORCA-Flash4.0 LT 12
Calibrate an Image from Pixels to Microns 14
Capture a Time Lapse Image Sequence 15
High Speed Streaming 20
TTL Input & Output 23
Analyze a Single Image - Advanced Mode 24
Sequence Intensity Analysis - Simple Mode 25
How to Merge Several Monochrome Images 26

Batch Export
Batch Export DCIMG to MPTIFF 27
Install HCImage Live 32-bit on a 64-bit Operating System 28

2 www.hcimage.com



INSTALLATION
HCImage Live
1. Insert the HCImage Live installation DVD into the DVD-ROM drive. If autoplay is enabled, the

HCImage Live setup will run automatically. If autoplay fails to start, locate your DVD-ROM
drive and double-click setup.exe.

2. Click Yes, if prompted by the User Account Controls.
3. Review the Software License information and click Yes.
4. Review the README section for up-to-date information on software compatibility and support.

When you are ready, click Yes.
5. On the Personalize screen, enter your registration information and click Next.
6. Choose the Destination Folder and click Next. It is recommended to install the software in

the default path.
7. If you are ready to proceed with the installation, click Install.
8. Follow the instructions on each installation page.
9. Click Finish, when the installation is complete.
10. Install the appropriate DCAM-API drivers, see the instructions below, then turn the camera on

before launching HCImage Live. If the drivers have not been installed, or the camera is not
turned on before launching HCImage Live, the camera will not be available in the software.

11. Click the HCImage Live icon on the Desktop to launch HCImage Live.

Install DCAM-API Drivers
Before installing the camera driver, make sure that the camera is turned off.

1. After installing HCImage Live from the DVD, you will be prompted to install DCAM-API, click
Yes. If you downloaded HCImage Live, please go to http://www.dcam-api.com/ and
download the DCAM-API drivers for Windows.

2. Click Yes, if prompted by the User Account Controls.

3. Select the appropriate driver
for your Hamamatsu camera
from the DCAM-API Setup
dialog. If you are unsure of
which driver to install, please
consult the DCAM-API
Compatibility Note or contact
your local Hamamatsu
representative. To view
DCAM-API Compatibility
Note, select Others and then
click Compatibility Note.

4. Click Next to begin the
installation.

5. Follow the instructions on
each installation page.

6. Click Finish when the installation is complete.
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Line Profile
The Line Profile is a useful tool that allows users to draw a line on the image and see the
corresponding intensity values plotted on a graph. The line profile may be used on a live or a
captured image or image sequence. For two and three channel color images, an intensity profile is

plotted for each channel as it's respective color. Click the Line Profile icon ( ) and then draw a
line on the image. See the Line Profile Properties below for a list of drawing tools. The Line Profile
may be toggled on/off by clicking the Line Profile icon .

Line Profile Properties
The Line Profile icon is located in the Annotations toolbar, click the Line Profile drop-menu to view
the line properties. The Line Profile Properties are defined below.

l Line Thickness: adjust the line thickness from one to five pixels, the selected thickness is
displayed on the toolbar icon

l Single: left-click, hold and draw a single straight line
l Segmented: create an open polygon by left-clicking to define a starting point, then left-click
to create an end point for each segment, and right-click to complete the line

l Free-hand: left-click and hold, then using the mouse trace the line on the image
l Clear: delete the current line profile

Viewing the Data
The intensity values for the line are plotted in a graph. The graph can be undocked and resized for
optimal viewing. It is continually updated, when live or during playback. The intensity data can be
exported to a spreadsheet and saved as a .csv (comma separated values) file. If a calibration was
used, the scale factor values will be included in the exported data. There are two options for
exporting data to a spreadsheet:

1. Export Data to Spreadsheet: export the intensity values for the current image
2. Export Data to Spreadsheet (all fields): export the intensity values for all of the fields in

the data set

Note:When using the ORCA-Flash4.0 LT, ORCA-Flash4.0 V2 or the ImagEM X2, the pixel values
for line profile will be plotted in gray levels and electrons for monochrome images. For color

images, the user can toggle between the two by clicking the Electron Count icon ( ). Both pixel
values will be exported.
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Filter Control using TTL
TTL can be used to control many types of devices, this example explains how to use the parallel
port as an I/O device and configure it to control an LED light source. LED light sources, like the
Lumencor Spectra and the CoolLED pE-2, provide high-speed switching between wavelengths and
don't require a shutter.

Filter Setup
In this example, the LED turns on when the pin state is high and off when the state is low. Pin 2
controls the Red LED, Pin 3 the Green LED and Pin 4 the Blue LED.

1. Go to the Devices pane, expand the Filter Setup panel enable I/O Devices.
2. Next, make sure that Return to Idle on Exit, Return to Idle After Capture and Return
to Idle During Delay are enabled.

3. Select Default Idle Positions, then select
LPT1 Output under Filters in the I/O Device
tab.

4. Click the ellipses to the right of Don't Care in
the first line.

5. Enable pin settings by clicking Don't Care
(should be unchecked).

6. Click OK. For the default state, all of the LEDs
should be off.

7. Under Shutters, select LPT1 P2, use the drop
menu to the right of Don't Care and set the
state to Low.

8. Set the pin state to Low for LPT1 P3 and LPT1
P4.

9. Click Add, enter Red as the filter name and
click OK.

10. Right-click on the filter and select Red from the
tint list.

11. Select LPT1 Output under Filters in the I/O
Device tab and click the ellipses.

12. Uncheck Don't Care, enable Pin 2 and click
OK.

13. Go to Shutters in the I/O Device tab and set
the LPT1 P2 state to High and the state to Low
for LPT1 P3 and LPT1 P4.

14. Now add the Green filter, tint it green, enable
Pin 3, then set the LPT1 P3 state to High and
the state to Low for LPT1 P2 and LPT1 P4.

15. Add the Blue filter, tint it blue, enable Pin 4,
then set the LPT1 P4 state to High and the
state to Low for LPT1 P2 and LPT1 P4.
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The Capture Pane
The Capture Pane provides a flexible and comprehensive method to access the camera's features
and functionality. The Capture Pane is organized by functionality into panels that can be expanded
when in use or collapsed when space is needed. The capture controls at the top of the pane (shown
below) are always visible and used for controlling how images are acquired and displayed.

Capture Presets
Capture settings can be saved as presets and then loaded when needed. Create multiple capture
presets to easy change between frequently used capture settings. Capture presets may be selected
from a list of saved presets available in the Capture Presets panel, located at the top of the Capture
pane. To add, remove, rename or view the settings of a preset, click the ellipsis to the right of the
list, to open the Capture Presets dialog. Capture presets save basic settings such as the capture
mode, channels, filters, exposure times, as well as output trigger settings and advanced camera
properties. For a list of the camera settings that are saved, select a capture preset from the
Capture Presets dialog and click View. HCImage will load the capture settings from the previous
session when launched.

Note: Capture presets are not automatically saved before changing presets or exiting the
software. To make changes to a saved capture preset, select the capture preset from the list,
adjust the capture settings and click Save.
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Camera Control
Manage capture settings using the individual channel and exposure controls.

Hint: In order to achieve the best possible acquisition speed when acquiring color images, set the
same exposure for each channel. Once the exposures have been entered, click the Exposure Lock

icon ( ) to lock the exposure settings. Now any exposure adjustments will be made to
all of the channels.

Binning and SubArray
With a CCD camera, 2x2 binning increases the signal to noise ratio by a factor of four and increases
the speed of image acquisition by a factor of about two. With an sCMOS camera binning is purely
digital, 2x2 binning increases the signal to noise ratio by a factor of two. Digital binning does not
increase the speed of image acquisition. Adjust the spatial resolution using a subarray preset for
increased speed and less data throughput. For sCMOS cameras a subarray must be centered on the
camera sensor in order to achieve maximum speed. The subarray preset sizes for in the list are
automatically centered (for sCMOS) but custom arrays are not. To center a custom array, see the
example below.
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Define a Custom SubArray for Maximum Speed (ORCA-Flash)

Click Live, focus on the sample and move the area of interest into the center of the image. Follow
the steps below to define a custom subarray.

Trigger Modes, Speed and Registration
By default the camera is controlled through software but some cameras offer advanced triggering
features allow the camera to control external devices or be controlled by them. The speed, capture
mode and output trigger settings can be adjusted based on the needs of the application. The
example below describes options for the ORCA-Fusion.
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Output Trigger Options

The camera provides a range of trigger output signals to synchronize with an external instrument
where the camera becomes the master and the external instrument becomes the slave. There are
three different trigger output functions, as well as a continuous High output (High output fixed) or
continuous Low output (Low output fixed). For a detailed description of each of the output trigger
options, please see "Camera Trigger Output" on page 1.

Advanced Camera Properties
DCAM Properties provide a list of camera parameters reported by DCAM. The camera properties
and reported values are specific to the connected camera and in some cases provide access to
additional functionality based on the capture mode. These properties are referenced in text and
screenshots as needed for setting specific camera modes. Most of the camera properties in the list
display values that cannot be changed and appear grayed out.

Processing
The Processing Panel provides the opportunity to enhance images during focus and acquisition by
incorporating image-processing operations during or immediately after image Capture. To select an
Image Processing operation, first expand the Process Pane and then select the Operation Type.
Rolling Average and Frame Integration are used for noise reduction. Use the image arithmetic
functions like Shade Correction, Background Subtraction or Image Subtraction to remove artifacts
from the incoming image. Clicking Capture1 will initiate image capture with the selected image
processing operations applied.

Note: For Image Correction or Arithmetic, the user must first choose a source or background
image. The image may be the current image saved in a buffer or one previously saved to disk. To
use the current image, make sure Processing is OFF, select Buffer, click Capture and then select
Shade Correction, Background Subtraction or Image Subtraction. Use the same method when using
an image from Disk.

Hint: Enable Processing ON for correction image when you would like to capture a correction
image using Rolling Average or Frame Integration. When you are ready to capture the correction
image, select Rolling Average and enter the number of frames, enable Processing ON for
correction image and then click the Capture button to the right of Buffer. The captured averaged
image is stored in the buffer and ready to use a correction image.
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How to Setup a Background Subtraction

Typically used in fluorescence microscopy, a background subtraction can be used when the image
presents a dark non-uniform background. To perform a background subtraction click Live, bring the
sample into focus and then move the stage off of the sample so that only the background is visible.
Next, follow the steps below, when finished move the stage to bring the sample into view and the
background subtraction is applied.

Hint: HCImage remembers the capture settings from the previous session, if background
subtraction was left enabled, the following message will appear the next time HCImage is
launched.
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Capture a Color Image
Capturing a color image requires filter setup, for instructions on setting up an LED light source in
HCImage Live, please see "Filter Control using TTL" on page 5.

Hint: In order to achieve the best possible speed when acquiring color images, set the same
exposure for each channel. Once the exposures have been entered, click the Exposure Lock icon (

) to lock the exposure settings. Now any exposure adjustments will be made to all of
the channels.

Using AutoSave
Enabling AutoSave will automatically save the current image every time Capture1 is selected. The
captured image is saved as a TIFF based on the file name and destination directory defined in the
AutoSave Properties dialog.

1. Enable AutoSave and then click on the ellipses to open the AutoSave Properties dialog.
2. Enter or navigate to the destination directory.
3. Enter the file name and the starting image number,

subsequent captures will be number sequentially.
4. Click OK.
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W-VIEW and the ORCA-Flash4.0 LT
HCImage Live supports the W-VIEW GEMINI for simultaneous dual wavelength image acquisition
using the ORCA-Flash4.0 LT. The W-VIEW GEMINI uses image splitting optics to project the two
wavelengths of interest (side by side) onto the sensor of the camera. This means that the effective
size of the field of view is approximately half the sensor size. The W-VIEW GEMINI was designed to
take advantage of the large field of view of the ORCA-Flash4.0 providing approximately 2000 x
1000 pixels for each image. HCImage Live incorporates W-VIEW mode, a multi-view functionality,
allowing the ORCA-Flash4.0 LT to function in a similar manor as using dual cameras. The W-VIEW
mode allows for independent exposure time settings, independent readout directions and separate
position offset for subarray.

Note: With W-VIEW mode, the readout direction in the upper and lower half of the sensor can be
setup separately. The readout direction for View 1 (top half) and for View 2 (bottom half) can be
set to Forward or Backward under DCAM Properties in the Advanced Camera Properties panel.

Capture Modes
HCImage Live will automatically detect the ORCA-Flash4.0 LT as two cameras, a normal camera
and as a camera in W-VIEW mode. Select C11440-42U S/N: #### for normal mode or C11440-
42U S/N:#### W-VIEW for W-VIEW mode from the Capture Device list. W-VIEW capture modes
include: Mono 1 Channel, RGB Color 2-Band and Mono 2 Channel. To select a capture mode go to
the Capture panel and click on the drop-menu above the Live button. The Camera Control pane is
modified based on the capture mode selected. The capture modes are explained in detail below.

Mono 1 Channel

In the single channel monochrome mode, the user can select which image to display, only one
image will be displayed at a time. Click on the 1 or 2 button to select which image will be displayed.

RGB Color 2-Band

The RGB Color 2-Band mode displays a merged red-green image from image 1 and 2.
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Mono 2 Channel

In the two channel monochrome mode, both images 1 and 2 are displayed (i.e., the whole camera
sensor is displayed).

Image Alignment
The Camera Registration
feature allows the users
while Live to flip and
rotate the image. Click
on the Registration
button in the Trigger
Modes, Speed and
Registration pane to open
the Camera Registration
dialog.
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Calibrate an Image from Pixels to Microns
1. Open or capture an image with some known distance, for example a micrometer.

2. Click on the Calibration Properties icon ( ) on the Analysis toolbar.
3. Enter a Title for the calibration file (e.g., 10x). SelectMicrons from the Units drop-menu.
4. Click Calibrate. Move the cursor to the start of a known distance; click and drag a line to

span the distance to measure.
5. Enter the known distance of the line and click OK. The Calibration Factor in the Spatial

Calibration Menu will be updated.
6. Click Add and repeat the previous steps for adding additional calibrations.
7. [Save Calibration] Click OK > Select file path > File name > Save. The Spatial Calibration

is displayed in the lower right-hand corner of the image file.
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Capture a Time Lapse Image Sequence
The Time Lapse scan provides flexibility and a variety of options for defining a time lapse to fit the
needs of your application.

Scan Settings
The Scan Settings panel provides multiple options for defining speed, storage, duration and output
settings. Scan settings can be saved for future use.

Note: Select Enable Maximum to acquire at maximum speed. During maximum speed, items
which slow down acquisition will be ignored.

www.hcimage.com 15



Auto Save

In the AutoSave Properties dialog, the user can determine how and where to store the acquired
data. Image data can be saved as a CXD, TIFF or MPTIFF. The example below provides a
description of the Auto Save Properties dialog.

Note: MPTIFF files have a 65,000 image limit or a 4 GB size limit. For image sequences having
more than 65,000 images or larger than 4 GB, multiple MPTIFF files will be saved and numbered
sequentially.

Storage Options
The three options for storing acquired data during a time lapse include saving to Disk, Memory or
Temporary Buffer.

Save to Disk

Acquired data is written directly to the hard drive. Frame rates vary based on the PC configuration,
including the type and speed of the hard drive(s) being used.

Save to Memory

Acquired data is stored in memory and then written to disk when the time lapse is complete or
stopped. When the system runs out of memory during a time lapse, acquired data is written to disk
for the remainder of the sequence. Saving to memory typically provides a higher frame rate with
less timing variation then saving to disk. The maximum number of images that can be acquired
depends upon the amount the RAM in the system and the RAM limit set in HCImage. This number is
displayed to the right of the memory storage option. When Memory is selected, End Frame
automatically displays the maximum number of frames that can be streamed to memory, although
any number less than the max can be entered. The Status Bar, located in the bottom left corner of
the application window, displays the maximum number of frames that can be streamed to memory.

Save to Temporary Buffer

Acquired data is stored in memory with the option to review the image sequence before saving or
deleting it. Storage is limited to the amount of system memory without the option to write to disk
when the memory is full. The maximum number of images that can be acquired depends upon the
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amount the RAM in the system and the RAM limit set in HCImage. When Temporary Buffer is
selected, End Frame is automatically enabled and display the maximum number of frames that can
be streamed to memory, although any number less than the max can be entered.

Note: Streaming to the Temporary Buffer is very useful because it provides the option to review
the image sequence when trying to capture specific event and for demonstrating camera speeds.

Setting up a Time Lapse
This section provides three examples of typical time lapse settings, using each of the storage
options.

Setup a Time Lapse - Save to Disk

The time lapse in this example will acquire an image every 30 seconds for 3 hours and the data will
be saved as a cxd. Once your are satisfied with capture settings and the sample is in focus, go to
the Sequence pane and follow the steps below.
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Setup a Time Lapse - Save to Memory

The time lapse in this example will store images in memory until the acquisition is stopped or runs
out of memory at which point the acquired images are saved to disk for the remainder of the time
lapse. Once your are satisfied with capture settings and the sample is in focus, go to the Sequence
pane and follow the steps below.
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Setup a Time Lapse - Save to the Temporary Buffer

Once your are satisfied with capture setting and the sample is in focus, go to the Sequence pane
and follow the steps below.
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High Speed Streaming
High Speed Streaming is used to obtain the fastest acquisition speed from the camera. This scan is
optimized for single channel streaming to RAM or directly to the computer's solid state drives (SSD)
configured in a RAID 0.

Note: Acquisition rates will vary based on the PC configuration, for information about the
computer requirements, please see the PC Recommendations for ORCA-Flash4.0 V2.

Note: High Speed Streaming does not support multi-channel acquisition, camera registration
features (i.e., flip, rotation and pixel shift) or software processing operations (e.g., shade
correction and rolling average).

Stream to RAM
When streaming to RAM, the image data is stored in memory and then the user has the option to
save as either CXD, TIFF, MPTIFF or to delete the data. Up to 80% of the systems available
memory will be used for storing streamed data. The Status Bar, located in the bottom left corner of
the application window, displays the maximum number of frames that can be streamed to memory.
In the AutoSave Properties dialog, the user can determine how and where to store the acquired
data. Once the acquisition is complete, the data stored in memory can automatically be saved as a
CXD, TIFF or MPTIFF.
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Note: MPTIFF files have a 65,000 image limit or 4 GB size limit. For image sequences having more
than 65,000 images or larger than 4 GB, multiple MPTIFF files will be saved and numbered
sequentially.

Circular Buffer

The Circular Buffer stores streamed data in memory, once the frame count has been reached, the
previous acquired data is replaced sequentially. The cyclic process repeats until the acquisition is
stopped, leaving the most recent images stored in RAM.

Steps for Streaming to RAM

Once your are satisfied with capture settings and the sample is in focus, go to the Sequence pane
and follow the steps below.

Stream to Disk
When streaming to disk, a temporary file (.dcimg) is created to store the data while it is being
acquired, the temporary file location needs to be located on the RAID array, SSD drive, or the
fastest drive available.
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Steps for Streaming to Disk

Configure the capture settings, go to the Sequence pane and follow the steps below.

Note: To leave the streamed data as a DCIMG file disable AutoConvert.

Steps for Batch Export DCIMG to MPTIFF

Go to the File menu, select Batch Export and follow the instructions below.
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TTL Input & Output
The example below will provide a quick overview on how to configure the parallel port to start and
stop a sequence, trigger capture events by receiving TTL pulses and how to output TTL pulse based
on capture events. Go to the Device panel and click I/O Setup. The Capture Events tab is divided
into Capture Inputs and Capture Outputs.

Note: The description and instructions below only cover some of the types of capture events, for
more information please consult the Help in the software or on the HCImage website
(http://hcimage.com/help/index.htm).

Capture Events
For Capture Inputs, Sequence Start and Stop, choose input pins and pin state. To start a sequence,
click under Frequency to choose when to trigger. Each click will cycle through the list of choices:

l Each Field - Waits for an input trigger at the beginning of every capture cycle
l First Field - Waits for an input trigger at the start of the sequence
l Each Pass - Waits for an input trigger before the first field of each sequence pass

For Capture Outputs:
l Sequence On - Will set the chosen state of the pin at the beginning of the capture. This pin
will remain at the specified state until the sequence has completed.

l Field On - Will set the chosen state of the pin at the start of a field's exposure. This pin will
signal on and off as each field is captured.

l Exposure On - The TTL output for the duration of each exposure.

Configure Capture Events
The table below provides the basic steps for setting up capture events.
Setup Capture Inputs: Setup Capture Outputs:

1. Select input pin 1. Select the capture output type
2. Set the input pin state 2. Select the output pin
3. Select the capture frequency 3. Set the output pin state
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Analyze a Single Image - Advanced Mode
Using the advanced mode, detect and analyze the size and the intensity of multiple objects of
interest in a single image.

1. Enable the Advanced Analysis mode by clicking View on the menu bar, then highlighting
Analysis Mode and selecting Advanced.

2. Open or capture an image, click on the Analysis pane and select Single Image Measure
from the Choose Type of Analysis drop-menu.

3. [Threshold the Image] Press the Identify icon under Detect Objects. Set the intensity
threshold by adjusting the Min. and Max. sliders until the objects of interest are highlighted
by a green binary overlay. Click OK.

4. [Modify the Binary Image] Click Modify to edit the binary overlay. Select any binary
operation you need to modify the binary overlay with a binary filter, such as Erode, Dilate,
Close, Open, etc; click OK.

5. [Remove Unwanted Objects] Click the Qualify icon. Reject unwanted objects by area by
adjusting the Min. and Max. sliders. Objects to be removed will appear red. Additional
qualifying parameters can be added such as Mean_Grey and Length, by clicking the Add
button.

6. [Measure the Image] Click Measure > Select the type of Measurements > OK > Click
Measure to DataDoc > Save data file.

7. [Review the Measurements] Click on a data value to identify the object that corresponds
to the data value and vice-versa. The data document contains Object Summary Statistics,
Object Summary Graphs, Field Summary Statistics, Field Summary Graphs, Field Image
Montages and Field Data. Data can be printed or exported to a spreadsheet by selecting Copy
to Spreadsheet under the Edit menu.
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Sequence Intensity Analysis - Simple Mode
Sequence Intensity Analysis will measure the intensity of a single object in the image sequence. If
multiple areas are drawn or identified, they are treated as a single object. HCImage has two
modes, the Simple mode is active by default but can be changed by clicking View on the menu bar,
then highlighting Analysis Mode and selecting Advanced.

Note: Change the overlay color to silver instead of green in the Change Overlay Color icon.
Use the translucency slider to adjust the overlay transparency or hide it by selecting View
Overlay. Click Clear to delete the overlay.
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How to Merge Several Monochrome Images
In HCImage, there are a couple of ways to create a merged image. The procedure outlined below
describes the drag and drop method of combining multiple images into a single merged image.
Keep in mind that the original image is not altered, the merged image is layer that can be turned on
or off. In order to keep the merged image, the display image must saved, see below.

1. Open all of the images that will be merged.
2. Click the Toggle SideBar icon ( ) if the SideBar is not visible. The Toggle SideBar icon is

located in the Status Bar at the bottom left corner of the image.
3. Select a source image and then drag and drop the thumbnails of the other images on to the

thumbnail of the source image. The merged image is displayed along with thumbnails of each
of the overlay channels.

4. Apply color to an image, right-click on a thumbnail and select a tint from the Tint drop-down
menu. Repeat the process for each image.

5. Adjust the contrast for the individual overlay channels, right-click on the thumbnail and select
Contrast. Make adjustments using the sliders in the Display Contrast dialog.

6. Click the Split Channel icon ( ), located in the top left corner of the SideBar, to enable
viewing of the individual overlay channels. When Split Channel mode is enabled, click on a
thumbnail to display the corresponding overlay channel. Click the Split Channel icon to view
the merged image.

7. [Merged Image On/Off] Right-click on a thumbnail and selectMerge On or click the

Apply Merged Display icon ( ) in the Display toolbar.
8. [Save the Display Image] Right-click on the image > Save Image to File > Display Image

> Enter file name > Save.
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BATCH EXPORT
When batch exporting all of the source files must be in the same directory and of the same file
type. Source file types include: Data documents (.cxd), Movies (.avi), Multi-Page TIFFs (.tif) and
DCIMG Files (.dcimg). Destination file types include: Data documents (.cxd), Movies (.avi), TIFF
Files (.tif), Multi-Page TIFFs (.tif), ), Bitmap (.bmp), JPEG (.jpg), and PNG (.png).

Note: MPTIFF files have a 65,000 image limit and 4 GB size limit. For image sequences having
more than 65,000 images or larger than 4 GB, multiple MPTIFF files will be saved and numbered
sequentially.

Batch Export DCIMG to MPTIFF
In the File menu select Batch Export and follow the instructions below. The exported files are not
automatically opened in the software.

Note: Depending on the destination file type, certain options are available.
l Convert 16-bit to 8-bit: Converts 16-bit monochrome images to 8-bit and will convert
48-bit color images to 24-bit. All movies (.avi) are exported 8- or 24-bit files.

l Create folder for TIFF series: Creates a folder for each exported TIFF or Multi-page
TIFF series (i.e., one folder is created for each source file). This option is turned on by
default but can be disabled.

l Video Compression: Use a video compression algorithm when converting to movie file
format. The compression algorithms are based on the video codecs installed on the
computer. Video compression is only available when exporting to movies (.avi).
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Install HCImage Live 32-bit on a 64-bit Operating System
There are some instances were the 32-bit version of HCImage Live will need to be installed on a 64-
bit machine. This is the case for the C10633 (inGaAS) cameras, which are only supported with
Windows 32-bit support on any Windows 64-bit (x64) operating system. The instructions below
provide the steps for installing HCImage Live 32-bit on a 64-bit operating system.

1. Cancel the Installation Wizard by clicking Cancel, click Yes to exit setup and then click
Finish to close the Wizard.

2. Open My Computer, select the media drive with the HC icon, open the Win32 folder and
double click Setup.exe.

3. Follow the instructions on the Installation Wizard to install HCImage Live.

Hint: If you are unsure if the operating system is 32-bit or 64-bit, press and hold theWindows
Logo + Break keys to view the System Properties window. Look for the System Type to find
out which version of the operating system is installed.
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